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Intalling Softwares



LUMEN

R langage

Ris a programing langage dedicated to statistics and data sciences.
 easy to use (simple synthax especially using the tidyverse)
 free (that makes a huge difference with Stat, SAS, Eview, SPSS...) and multi-platform (windows, OS, Linux)

« evolutive (a very important community develop applications -free packages- and makes 'R base' evolve
on a regular basis)

« alot of information available (R journal, R bighook, R-BLOGGERS, Stack overflow, freakonometrics,
MyEconTricks...)
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https://journal.r-project.org/
https://www.bigbookofr.com/finance.html
https://www.r-bloggers.com/
https://stackoverflow.com/
https://freakonometrics.hypotheses.org/
https://myecontricks.netlify.app/

LUMEN

R langage

You can download R at the following adress https://www.r-project.org/ .
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https://www.r-project.org/

LUMEN

R Studio IDE

e Whatis a IDE ?

It is just a Interactif Developpement Environment, a software that helps to deal with application creation using
one or more programing language.

R Studio is dedicated to data analysis. It provides tools to get data, to shape data (data wrangling), to draw
graphs, to do statistics (test, regression models, other modeling...) and to produce reports (presentations, text
documents, interactive product...).

Actualy, R studio is becoming posit. It will give more space to other programing langage (like Pyhton,
Julia,C++...).
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R Studio IDE

You can download R Studio at the following adress https://www.rstudio.com/products/rstudio/download/ .
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https://www.rstudio.com/products/rstudio/download/

LUMEN

Video installation guide

To help you to install R and R Studio IDE, I invite you to watch the follow trought video (duration about 5
minutes) here after.

https://youtu.be/hT2tSvj7d1A
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https://youtu.be/hT2tSvj7d1A

LUMEN

Presentation of the R Studio environement

You will find a short presentation of the R Studio in the following video (duration about 15 minutes).

https://youtu.be/fB5QlyjWqKO0
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https://youtu.be/fB5QlyjWqK0

LUMEN
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Presentation of the R Studio environement
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Presentation of the R Studio environement

Four panel layouts
» Source : where you write your program and save it to make your analysis reproductible.
e Console : where you interact with R.
« Environment : where you find the different objects that you have created during your session.

- Files, Plots, Packages, Help, Viewer, Presentation : you find the files in your working directory, you can
view the graph made, the list of your installed packages, some descriptions of fonctions for which you
have asked for help...
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LUMEN

Presentation of the R Studio environement

It is important to create a new project when you start a data analysis.

file -> new project

Indicate where to put the directory associated with your project and name it.

If you have some doubt on your actual working directory type getwd() in the console space.
In order to make your work reproductible, you must at least use a script file.

file -> new file

Warning : it is not because you have saved your project (.Rproj) that your data and your programs (.R,.Rmd...)
are also saved (.csv,.xISx...). You have to save them independly!!
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R langage basis



The operators

e math: +, -, %/, %/%,

%x%, t(), ", log(), exp()...

 assignation: <-=->

 logical: <> <=>===1=%in%
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The data types

o Character
e numeric:
_logical (0 FALSE 1 TRUE)
_factor
_linteger
_double

_etc...
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The data objects

e vector
e matrix
e array
e list

e data frame

Working Environnement and data base - LV 16 /117




LUMEN

The functions

There are commands that transform or produce new elements from a R object or a part of a R object.
There are shaped as follow : name_of_the_function(main arguments, options)

sum(x,na.rm==TRUE) make the sum of the element of vector named x. The option na.rm==TRUE excludes
from the sum the NA values.

x<-c(1:6,NA,c(5:9)-2)
X

## [1] 1 2 3 4 5 6NA 3 4 5 6 7
sum(x)

## [1] NA

sum(x,na.rm=TRUE)

## [1] 46
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LUMEN

Find some help about a function

Use the help window or just put ? in front the function name.
?2t.test()

## démarrage du serveur d'aide httpd ... fini
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The syntax

R base has a stacked syntax.
paste(mean(x[x<5],na.rm=TRUE), 'on average')

## [1] "2.83333333333333 on average"
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The syntax

R base has a stacked syntax.

## [1] 1 2 3 4 5 6NA 3 4 5 6 7
x<5

## [1] TRUE TRUE TRUE TRUE FALSE FALSE
x[x<5]

## [1] 1 2 3 4 NA 3 4

mean (x[x<5],na.rm=TRUE)

## [1] 2.833333
paste(mean(x[x<5],na.rm=TRUE), 'on average')

## [1] "2.83333333333333 on average"
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Intall and use packages

With R you have access to a wide panel of functions developped by the community. You can download
packages of new functions from online repositories (like the CRAN, or github...).

Let's download the tidyverse package which includes a lot of usefull complementary fonctionality.

install.packages("tidyverse")
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LUMEN

Intall and use packages

Once a package downloaded, you have to call it in your environment in order to use the included functions.

library(tidyverse)

## — Attaching packages tidyverse 1.3.2 —
## v ggplot2 3.3.6 v purrr 0.3.4

## v tibble 3.1.8 v dplyr 1.0.10

## v tidyr 1.2.0 v stringr 1.4.1

## v readr 2.1.2 v forcats 0.5.2

## — Conflicts tidyverse_conflicts() —

## X dplyr::filter() masks stats::filter()
## X dplyr::lag() masks stats::lag()
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LUMEN

Intall and use packages

The tidyverse provides (among many other things) a usefull programing operator the simplify R syntax : the
pipe operator %>% (keyboard shortcut 'ctrl’ 'shift' 'm").

x<-1:5
y<-8:4
data.frame(x,y) %>% summarise(m_x=mean(x),m_y=mean(y))
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Intall and use packages

It is simpler than :
lapply(data.frame(x,y), mean)

## SX

## [1] 3
##

## Sy

## [1] 6

sapply(data.frame(x,y), mean)
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The home made functions

You can create you own function using the following syntax.
function_name<-function(arguements,...){
one program that do the job!!

}
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The home made functions

Let's build a function that compute the actual value of a given amount of money in n compounding periods
when the opportinity interest rate is i.
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The home made functions

Let's do the math.
Vif=VAx(1+1i)"

VF

VA=
(1+ )"
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The home made functions

Let's do the program.

val_act<-function(vf,i,d){
va<-vfx(1/(1+i)"d)
return(va)

}
Let's test it.
val_act(1159.2741,0.03,5)

## [1] 1000
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The home made functions

Create a function that computes the annual interest rate allowing to obtain the final value from the initial one
in n periods. (5 minutes)
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The home made functions

Let's do the math.
VF=VAx(1+i)"

Vi _
VA

Vf 1/n '
- J -1
(VA> +1

%—(VZ) —1

(1+4)"
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The home made functions

Let's do the programing.

interet<-function(vf,va,n){
i<-(vf/va)*(1/n)-1
return(i)

}
Let's test it.
interet(1159.2741,1000,5)

## [1] 0.03
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More on R langage

You can watch (later) a 40 minutes video that presentes more extensively the points that we have just review.
You can find it at the followning adress:

https://youtu.be/hGffaVR4Dtk
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https://youtu.be/hGffaVR4Dtk

short break

Wow, a different
error message...
Finally some progress!

AGENT-X COMICS & WWW AGENT-X.COM.AU
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WRDS data base



LUMEN

Access to WRDS

You start from your Student ENT. You select "toutes les applications” and on the part dedicated to
'‘Bibliotheque' you click on 'Ressources électronques'.

ent -> toutes les applications -> Bibliotheque -> ressources électroniques

Once the 'ressources électroniques' page opens go to 'Accueil’ and section the 'gestion’ discipline. You can find
the link with WRDS at the bottom of the current page.

Accueil -> gestion -> wrds
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Access to WRDS
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& wrdswn-vi o

Basescedomdes [ Cows [ Conrences [ s

FFWharton s pauessc

DATASERVICES

# Home

Connect to WRDS

To access WRDS, please enter your email
address assigned by your subseribing insitution.
Welll send an email Lo this addres
information needed to sign in.

s with the

Emai address

Email address
Captena

Jene suis pas un robot

Why do we ask for an email
address?

We oc
running or problematic queries.

asionally need to contact users due 1o long

connec 2% DOB%oN

Usstregrise 7| Memodlogies | Sewes [ Réseauc o Stesdinto @ Epimémafinance L. »

s Analytics  EData Classroom @ About~  #MVideos % Demo

Welcome to WRDS!

Wharton Research Data Services (WRDS) provides the leading business intsligence, data analytis, and
rosaarch platform to global insttutions - enabling comprehensive thought leadership, historical analysis,
and insight into the latest innovations in ressarch.

For additional information, please see the About section.

I3 Connect with s on Facebook!

o@ :
e o
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Access to WRDS

Working Environnement and data base - LV

Geecedomss | Couws | Conencss | laee

arton yyrds mamoyssecn

DATASERVICES

# Home

Email Sent

We have just sent an email with the subject Your
WRDS Day Pass' from wrds-
support@wharton.upenn.eduto
ludovic.vigneron@univ-iller. Pleass cick on tne.
link in that email to sign in. Please also make sure
that your email iltering doss not mark emails from
wrds-support@wharton.upenn.edu as junk mail

B w 2608 % e

ok Memoscoger | Rewst | Remciccms | Steccins @ Emsmorivnce L b e e

184 Analytics S Data @ Classroom @ About~ B Videos ) Demo

Welcome to WRDS!

Wharton Ressarch Data Sevicss (WRDS) provides the leading business inteligence, data analytics, and
research platform to global insitutions - enabling comprenensive thought leadership, historical analysis,
and insight into the latest innovations in ressarch.

For additional information, please see the About section.

I3 Connect with us on Facsbook!

Uits University Management - ULA 4959
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Access to WRDS

Universte
(G

Contacts _ Calendrier _ Taches _ Préférences

epoare | i s | fovesume | _suppns | soom | b (@15) [ sctons - e s miomutons | 8 Atenge

v Dossersdemais % | e Vour WRDS Day pass
& rcepion <10 e wos e |- - (WRDS
2 oy ) Vour WRDS Day Pass - Dear WRDS User, Thank you for requesting a Day Pass | {udovic vigneron
Recherches .
Tgs el
@ o wR0s Dear WRDS User,
——
[0 ® R-bloggers newsletter 11 Acl
ToeE s e - - Feten acceptan reement to the WRDS Terms of Use. available here:
S 16 17 8 19 20 21 0@ TheRstioTeam hittps fhwrds-wn w n.upenn edu Hows
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Access to WRDS
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gWharton yrds
# Homo

Subscriptions

» Bank Regulatory a
» Beta Sute by WwRDS B
» Blockholders 1]

» CBOE Indexes [}

» Compustat - Capital 1Q

» Contributed Data at

» CRSP

» CSMAR | Sample
> DMEF Academic Data @

» Effcient Frontier by W... @

WHARTON RESEARCH
DATA SERVICES

il Get Data

» External Data Sources
» Fama-French Portfoi
» Federal Judicial Center
» Federal Reserve Ban.
» Financial Ratios Sute
» Historical SPDJI

» Intraday Indicators by
» Linking Suite by WRDS
» Macro Finance Society

» MSRB

I8« Analytics ~

e

]
a
o

Data Dashboard >

» Penn World Tables

» Peters and Taylor Tot.
» Philadelphia Stock EX.
» Public Data

» Research Quotient

» SEC Order Execution
» Subsidiary Data by W.
» Thomson/Refinitiv

» TRACE

» US Patents by WRDS

& Classroom ~

™Videos Ol Research~  ® Support

WRDS News

Research examines
06 [
8 cryptocurrencies and

tokens
sy oin 2022

E Best Paper winner

highiights the impact of

EYH Aronb on

suysin 2022

Events

European Finance
24 Association
AuG [
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Access to WRDS
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EFWharton g tamovmsee

T DATA SERVICES
4l Got Data v 84 Analytics v 7@ Classroom v

#4Home / GetData

Get Data

Data Products and Vendors at WRDS
Below are all available WRDS produts and vendors, including those to which your institution is

subscribed, and any trial products. To request addiional products or vendor subscriptions, please contact
the WRDS administrator al your insttution,

WRDS

> Beta Suite by WRDS

» Efficient Frontier by WRDS
> Event Study by WRDS

» Financial Ratios Suite by WRDS

> Intraday Indicators by WRDS

T p———

Q

®(Videos O Research~  © Support

Subscription

Al

Not Subscribed

e 9 Category:
@ > European Short Data by WRDS [ ViRDS

Third Party
@ e

Marketplace
a e Sample
@ > Linking Suite by WRDS @  Concept:

I VY= |
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LUMEN

Access to WRDS

You only have access to ressources marked by the plain blue links.
If you spend to much time without doing anything, you will be disconnected.

Your access is can be activated using the email link during a day long.
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LUMEN

What WRDS is?

It is a data base aggregator provided by the Wharton school of business of the university of Pennsylvania.
It allows to access multiple ressources in one place using a central data extraction interface.

It also provides some data treatement services (compute event studies, efficient portfolio, Beta...).
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What the main ressources available are ?

« Compustat : accounting data about listed firms

CRPS : share prices
o Thomson/Refinitiv (WRDS-Reuter Dealscan) : syndicated loan deals
» Trace : bonds

etc...
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LUMEN

What the main ressources available are ?

Each database has it own indivuals' (company or security or CEO...) identifier.

One of the first difficulties that you will have to deal with using those data base will be to manage those
identifiers in order to merge the data accuratly.

WRDS helps providing tables with merging keys (most of times).
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Extracting/importing data
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Extracting data from CRSP

The Center for Research in Security Prices, LLC (CRSP) maintains the most comprehensive collection of
security price, return, and volume data for the NYSE, AMEX and NASDAQ stock markets.

It is the gold standard data base on stocks in empirical finance (in US).

Most of the more important research papers published in top scientific journals (JF,JFE,JFQA...) have been
produced using CRSP.

46 /117

Working Environnement and data base - LV




Extracting data from CRSP
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» Bank Reguiatory

» Compustat - Capital 1Q

» Contributed Data at WRDS

» Federal Judicial Center

»

»

»

»

Blockholders

Bureau van Dijk

CBOE Indexes

CRSP

CSMAR | Sample

DMEF Academic Data

Extemal Data Sources

Fama-French Portfolios and Factors.

Federal Reserve Bank Reports

Subscription:

Category:
WRDS
Third Party
Marketplace
Sample
Concept

Analyst Estimates
Audit & Regulatory Fiings

Banks

Bonds and Fixed Income

Compensation

Derivatives / Options

Economics
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Extracting data from CRSP
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e e DATASERVICES

w3y

# Homo / GotDaa / CRSP

CRSP

NVharton (s wasonssesc: .

WRDS

lil GetData~ I Analytics~ 7 Classroom~ @ Videos G Research~ @ Support

New CRSP Format: Details available

Details are now available about the ef

nhanced Flat File Format 2.0 (CIZ)

CRSP has introduced a new Flat File Format 2.0 (CIZ) for the CRSP US 1925 and 1962

Stock and Stock with Index Databases. All sut

scribers — monthly, quarteriy, and annual ~ will

receive this premiere data cut when it becomes available in early August. WRDS will maintain
both current and new formats for two years. Please see the

Posted June 101h, 2022

Don't show this again B

The Center for Research in Security Prices, LLC (CRSP) maintains the most

comprehensive collection of security price, retum, and volume data for the NYSE,
AMEX and NASDAQ stock markets. Additional CRSP files provide stock indices,

beta-based and cap-based portfolios, treasury bond and risk-free rates, mutual

funds, and real estate data.

More About This Vendor »
Filtor by Concept / Region (show)
@ crermee

Wharton Research Data eri

1as

Wharfon

Knowledge Base >
» Stock

» Index and De
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Extracting data from CRSP
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ot Data > G5+ lassroom v C (osearon v

UpPOT

#4Home / GetData / CRSP / Annual Update

Stock / Securiy Files

CRSP G oo
W SECURITY PRCES LLC

Stock / Security Files

More About This Vendor »

@ CRSP - Basics.

[ ————

New CRSP Format: Details available
Details are now available about the enhanced Flat File Format 2.0 (CIZ)
CRSP has introduced a new Flat File Format 2.0 (CIZ) for the CRSP US 1925 and 1962

‘Stock and Stock with Index Databases. All subscribers — monthiy, quarterly, and annual - will
receive this premiere data cut when it becomes available in early August. WRDS will maintain
both current and new formats for two years. Please see the

Wharfon

Posted June 10th, 2022 Don' show this again 8

Stock / Security Files

Knowledge Base >
» Daily Stock File » Stock Header Info » Stock

> Stock Market Indexes » U.S. Dally Event Study: Upload your own » Index and Deciles

» Monthly Stock File » Identifying ETFs

Manuals and Overviews >
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Extracting data from CRSP

# Home / GetData /| CRSP / Annual Update / Stock /Security Files / Daily Stock File

CRSP Daily Stock CRSP s,
More About This Vendor »

Query Form [JVCUEIget

fiptions  Manuals and Overviews ~ Knowledge Base ~ Data Preview

CRSP >
CRSP Daily Stock Annual Update »

! ity Fil (hide)
You have 10 saved queries for this Query Form. Stock / Security Files ide

» Daily Stock File

Step 1: Choose your date range.

Date Variable: » Stock Market Indexes

2000-01-01 2022-03-31 » Monthly Stock File
» Stock Header Info
Step 2: Apply your company codes.
What format are your company codes? » U.S. Daily Event Study: Upload your own

@TICKER OPERMNO OPERMCO OGCUSIP ONCUSIP OHSICCD O SICCD

Select an option for entering your company codes: CRSP - Basics
-
® pany Code (u] Code Name Wharton Research Data Services.

Please enter company codes separated by a space Save this code list to Saved Codes.
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Extracting data from CRSP

CRSP i et

Step 3: Choose query variables.
More About This Vendor »

How does this work?

SRSV o1 | I<entifying Information @25 | Time Series Information (@o CRsP >

»  Annual Update >

Stock / Security Files (ide)

» Daily Stock File

» Stock Market Indexes

Select =al Selected Oclearall (0)

Cusip (cusip)

Neusip (ncusip)
» Monthly Stock File
Gompany Narme (comnam)

© 0o 0 0

Ticker (ticker) » Stock Header Info

CRSP Permanent Company Number (permco)
» U.S. Daily Event Study: Upload your ow.

‘Share Code (shrod)

Share Class (shrcls) CRSP - Basics

-
Wharton Research Data Services.

Nasdaq lssue Number (issuno)

Exchange Code (exched)

JOOOO 0OO0OOO0OO

©o 000 o

Header Fxchanae Cade thexer)
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Extracting data from CRSP
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Step 4: Select query output.

How does this work?

Select the desired format of the output file. For large data requests, select a compression type to expedite
downloads. If you enter your email address, you will receive an email that contains a URL to the output

file when the data request is finished processing.

Output Format Compression Type Date Format

comma.delimited text (* csv)
Excel spreadsheet (* xisx)
tab-delimited text (" tct)
HTML table (* htm)

SAS Windows_32 dataset (* sas7bdat)
SAS Windows_64 dataset ( sas7bdat)
SAS Solaris_64 dataset (* sas7bdat)
dBase file (* dbf)

STATAfile (* dta)

> SPSS file (* sav)

) zip (zip)
azip (".2)

E-Mail Address (Optional)

E-ma Edit Preferences

Save This Query (Optional)

fixed-width text (*.bc) ® Uncompressed

© YYMMDDNS. (e.0. 19840725)
O DATE9. (e g 25JUL1984)
DDMMYYS. (e.g. 250784)

O MMDDYY10. (e.g. 07/25/1984)
O DDMMYY10. (e g 25/07/1984)
O YYMMDDs10. (e.g. 1984/07/25)

Custom Field (Optional)

Notes on this Query (Optional)

Nof

» Stock

» Index and Deciles
» Identifying ETFs

Manuals and Overviews »
» Overview of CRSP U.S. Stock Database

» WRDS Overview of CRSP/COMPUSTAT
Merged (CCM)

» Stocks and Indices

Additional Tools

Merging CRSP and CRSP Basics
Compustat Data
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Extracting data from (RSP

Mission 1:

Find the ticker of a stock of your choice and put it in the chat window (company name followed by the
corresponding actual ticker).
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Extracting data from CRSP

Let's take Google.

A quick research on it provides us its ticker.
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Extracting data from CRSP
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Google

google ticker

Q Tous

Actualités Q) Shopping (2 I @ Lwes ¢ Plus

0 résultats (0,81 secondes)

aoe Alphabet Inc Class A

NASDAQ: GOOGL  §

Récapitulatif des marchés > Alphabet Inc Class A

111,04 uso

61 (4,81 %) + avjourd hui

5 m 4l
1
11088USD 1429
e
e
12
10 v T T
Ouverture 14,72 Gapitalis. 14580 Serede.COP

Aporgu ) | Comparaison

Outis

Données financisres

aD

Apropos

Alphabet Inc. ' sifebet est une entreprise américaine
basée en Calforie, créée en 2015 comme un
conglomérat de sociétés préoédemment détenues par
Ia sociélé Google. Wikipédia

PDG : Sundar Pichal (3 déc.

9-)
Date de fondation : 2 octobre 2015, Calfornie, Etats-
unis

Sidge social : Mountain Vie, Calformie, Etals-Uris
Nombre dlemployés : 174014 (2022)

Revenus

57,6 millards USD (2021)
Fondateurs : Larry Page, Serguel Brin

Fillales : Google, Waymo, Google Fiber, Decphind,
GV, X, Verll, PLUS

LUMEN
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Extracting data from CRSP
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Lou Have 1 Savew YusIES U1 U wuSty FUL

Step 1: Choose your date range.

Date Variable:

2000-01-01 2022.03-31

Step 2: Apply your company codes.

What format are your company codes?

ICKER OPERMNO OPERMCO OCUSP ONCUSP  OHSICCD O SICCD
Select an option for entering your company codes:

GOOGL a]

Please enter company codes separated by a space. Save Ihis code list 10 Saved Codes
Example: 1BM MSFT AAPL

[Cove Lookup: GRSP Stock (Annua |

-Select Saved Codes List-—r 5

Ghoose from your save

code ist.

Uploa a plain text fle (1), having one code per ine.

This metnod alow Please be aware that his take a very long tme to run

because 1L dependent upon i size of e database.

CRSP i metite

More About This Vendor »

CRsP »
Annual Update »
Stock / Security Files (nice

» Dally Stock Fi

» Stock Market Indexes.
» Monthly Stock File
» Stock Header Info

> U.S. Dally Event Study: Upload your ow.

w CRSP - Basics.

Wharton Research Data Services

Vb

LUMEN

UiSs Univarsity Management -~ ULA 4980
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Extracting data from CRSP

Step 3: Choose query variables.

How does this work? CRSP Wi ces e
asearonal G (gl [S——— More About This Vendor >
>
CRSP »
Select’ ®an Selected Ociearal 61) Annual Update >
e Pr— Stock / Security Files e
* @ Neusip (ncusip) » Daily Stock Fi
@ Company Name (comnam)
P —— » Stock Market Indexes
© GRSP o Conpany e » Monthly Stock Flle
permco)
@ Snare Cods (shred) » Stock Header Info
@ Sharo Giass (shcls)
» U.S. Dally Event Study: Upload your ow.
@  Nasdag lssue Number (issuno) i gty
@  Exchange Code (exchcd)
@ Heater Exchange Gode (nexcd) @ o
SRS o Wharton Research Data Services

How does this work?

[omo] oor ] Romor onre St Bake
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Extracting data from CRSP

Working Environnement and data base - LV

Step 4: Select query output.
How does this work?
Select the desired format of the output file. For large data requests, select a compression type to expedite

downloads. If you enter your email address, you will receive an email that contains a URL to the output
file when the data request is finished processing

Output Format Compression Type Date Format
O fixed-width text ( xt) ® Uncompressed © YYMMDD18. (6.9 19340725)

comma-deiimited text (* csv) ip (" Zip) DATES. (e.g. 25JUL1984)
Excel spreadsheet (* xisx) O gzip (.g2) O DDMMYY. (eg. 250784)

O tab-delimited text (" tx) O MMDDYY10. (e.g. 07/25/1984)

O HTML table (* htm) > DDMMYY10. (e.g. 25/07/1984)

) SAS Windows_32 dataset (" sas7bdat) O YYMMDDS10. (e g. 1984/07/25)
O SAS Windows_64 dataset (* sasTbdat)

O $AS Solaris_64 dataset (* sasTbdat)

O dBase file (" dbf)

O STATAfe (* dte)

O SPSS fie (*sav)

€-Mail Address (Optional) Custom Field (Optional)

X Edit Preferences Fie 2]

Save This Query (Optiona) Notes on this Query (Optional)

CRSP i mrcssiiie

More About This Vendor »

CRSP »
Annual Update »
Stock / Security Files i)

» Dally Stock File

» Stock Market Indexes

» Monthly Stock File

» Stock Header Info

» U.S. Daily Event Study: Upload your ow.

CRSP - Basics.
-

Wnarton Research Data Services.

0]

ML ¢

4
?

B S Wharran
> = @RV
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Extracting data from CRSP

4 Home / GetData / CRSP / Annual Update / Stock / Security Files / Dally Stock File

Working Environnement and data base - LV

Query successfully submitted.

CRSP Daily Stock

RN Variable Descriptions  Manu:

New CRSP Format: Details available

Knowledge Base  Data

Details are now available about the enhanced Flat File Format 2.0 (CIZ)
GRSP has introduced a new Flat File Format 2.0 (GIZ) for the GRSP US 1925 and 1962

Stock and Stock with Index Databases. All subscribers — monthly, quarterly, and annual — will
receive this premiere data cut when it becomes available in early August. WRDS will maintain
both current and new formats for two years. Please see the

Posted June 10th, 2022

CRSP Daily Stock

You have 10 saved queries for this Query Form.

Don't show this again M

CRSP &z ronneseancy
IN SECURITY PRICES, LLC

More About This Vendor »

CRSP »
Annual Update »
Stock | Security Files (oe)

» Daily Stock File

» Stock Market Indexes

» Monthly Stock File

» Stock Header Info

» U.S. Daily Event Study: Upload your own ...
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Extracting data from CRSP

Query 6064167, for crsp_a_stock

Status: Data Retention
Product; crsp_a_stock Results data will be accessible for
2 days, until 2022-08-28, 14:41
Results:
Result Size: Result Count:
1.2 MiB 4,436 Rows
Notice
Output Files:
jwrds_query_outputiydanvxeScruvhopb.osv Your use of WRDS and this data
extract must comply with the WRDS
Terms of Use.
Timing
Elapsed Time: Submitted: There may be additional usage restrictions
10 seconds 2022-08-26 14:41 that are governed by your institution's
licensing of spedific databases. If you have
Work Begun: Work Finished: any questions about data licensing and
2022-08-26 14:41 2022-08-26 14:41

appropriate usage, please contact WRDS
using the Support form.

Input Parameters: Toggle Input Parameters

Working Environnement and data base - LV 60/117




Extracting data from CRSP

Working Environnement and data base - LV

[T ——

# Home / Your Account / Queries / Query 6064167, for crsp_a_stock

Query 6064167, for crsp_a_stock

Status: Succes:
Product: orsp_a_stock
Results:
Result Size: Result Count:
12 MiB 4,436 Rows
Output Files:
« ~Jwds_query_outputiydanvxeScruvhcpb.csv
Timing:
Elapsed Time: Submited:
10 seconds 2022.08-26 14:41
Work Begun: Work Finished:
2022.08-26 14:41 2022.08-26 14:41

=

Data Retention

Results data will be accessible for
2 days, until 2022-08-28, 14:41

Notice

Your use of WRDS and this data
extract must comply with the WRDS
Terms of Use.

There may be additional usage restrictions.
that are govered by your institution's
licensing of specific databases. If you have
any questions about data licensing and
appropriate usage, please contact WRDS
using the Support form.

LUMEN

UiSs Univarsity Management -~ ULA 4980
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Extracting data from CRSP

Copy the downloaded file in your working directory.

Once done import your data in R.
google <- read_csv("google.csv'")

## Warning: One or more parsing issues, see problems()’ for details

## Rows: 4436 Columns: 63
## — Column specification
## Delimiter: ","

## chr (13): NCUSIP, TICKER, COMNAM, SHRCLS, TSYMBOL, PRIMEXCH, TRDSTAT, SECSTA...
## dbl (39): PERMNO, date, NAMEENDT, SHRCD, EXCHCD, SICCD, NAICS, PERMCO, ISSUN...
## 1gl (11): DCLRDT, DLPDT, NEXTDT, PAYDT, RCRDDT, DISTCD, DIVAMT, FACPR, FACSH...
H##

## i Use “spec()’ to retrieve the full column specification for this data.

## i Specify the column types or set “show_col_types = FALSE' to quiet this message.
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Extracting data from CRSP

let's see what do we have. head(google)

Show | 6 v entries Search:

PERMNO date = NAMEENDT SHRCD SICCD NCUSIP TICKER COM?
GOOG

1 90319 20040819 20050818 11 3 7375 38259P50 GOOG INC
2 90319 20040820 11 3 7375 38259P50 GOOG  00C
3 90319 20040823 11 3 7375 38259P50 GOOG ~ O0C
4 90319 20040824 11 3 7375 38259P50 GOOG  po0¢
5 90319 20040825 11 3 7375 38259P50 GOOG IGI\?COG
6 90319 20040826 11 3 7375 38259P50 GOOG ~ o0¢
>

Showing 1 to 6 of 6 entries Previous Next
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Extracting data from CRSP

unique (google$SPERMNO)
## [1] 90319

unique (google$SPERMCO)
## [1] 45483

unique (google$STICKER)
## [1] "GOOG" "GOOGL"
unique (google$CUSIP)
## [1] "02079K30"
unique (googleSCOMNAM)

## [1] "GOOGLE INC" "ALPHABET INC"
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Extracting data from (RSP

PERMNO (sercurity) and PERMCO (company) are unique identifier given once by crsp respectivily to a
security and a company they never change and are never reaffected.

There is no survivor biais in CRSP.

65 /117
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Extracting data from CRSP

Put the date variable on a date format.
str(googleSdate)

## num [1:4436] 2e+07 2e+07 2e+07 2e+07 2e+07 ...
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Extracting data from CRSP

You have to install the lubridate package to manage easily date format variables.
install.packages(lubridate)

Once the new package installed, call it in your working environment.
library(lubridate)

H#
## Attachement du package : 'lubridate'

## Les objets suivants sont masqués depuis 'package:base':

H#
# date, intersect, setdiff, union
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Extracting data from CRSP

So you can use ymd() function to format the date variable.

google$date<-ymd(googleSdate)

str(googleS$date)

## Date[1:4436], format: "2004-08-19" "2004-08-20" "2004-08-23" "2004-08-24" "2004-08-25" ...
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Extracting data from CRSP

let's see what do we have now. head(google)

Show 6 + | entries Search:

PERMNO date NAMEENDT SHRCD EXCHCD SICCD NCUSIP TICKER COMNA

1 90319 20 20050818 11 3 7375 38259P50 GOOG ~ OOCHE
2 90319 (2)2?246 11 3 7375 38259P50 GOOG IGI\?COGLE
g 90319 32?245: 11 3 7375 38259P50 GOOG IGI\?COGLE
E 90319 82?244 11 3 7375 38259P50 GOOG E\?COGLE
E 90319 ?,Sf’fs' 11 3 7375 38259P50 GOOG IGI\?COGLE
e 90319 (2)39246} 11 3 7375 38259P50 GOOG E\?COGLE

>

Showing 1 to 6 of 6 entries Previous Next
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Extracting data from CRSP

Let's check if we have duplicated observations.

google<-google %>% arrange(PERMNO,date) %>%
group_by (PERMNO,date) %>%
mutate (dup=n()) %>% ungroup()
table(google$dup)

##
## 1
## 4436
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Extracting data from CRSP

There is no duplicated observations. We can drop the dup variable.

google <- google %>% select(-dup)

Working Environnement and data base - LV 71 /117




LUMEN

Extracting data from CRSP

There is too much information in the actual data base. Let reduce it to the ones we need.

google<-google %>% select(PERMNO,COMNAM,date,PRC,RET,RETX,DIVAMT,DISTCD,
DCLRDT,RCRDDT,PAYDT)
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Extracting data from CRSP

When did google start to be listed?
min(googleS$date)

## [1] "2004-08-19"
Created in september 1998.

Did Google (Alphabet) pay some dividends since its listing?
unique (google$DIVAMT)

## [1] NA
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Extracting data from CRSP

No dividence, we can also drop the related information.

google<-google %>% select(PERMNO,COMNAM,date,PRC,RET,RETX)
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Extracting data from CRSP

Let's check if RET and RETX are always equal.
sum(google$RET==googleSRETX)

## [1] 4436

We can drop RETX.

google<-google %>% select(-RETX)

75 /117
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Extracting data from CRSP

How are returns established in CRSP?

Simple return

google$SPRC[2] /google$PRC[1]-1
## [1] 0.07948373
googleSRET[2]

## [1] "0.079484"

CRPS provides simple retrurns.
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Extracting data from (RSP

Returns (RET) are in character format. Lets transform the variable to make it numeric.
googleSRET[1:10]

## [1] "C" "0.079484" "0.010064" "-0.041408" "0.010775" "0.018019"
## [7] "-0.016310" "-0.039001" "0.003529" "-0.020709"

googleSRET<-as.numeric(google$RET)
## Warning: NAs introduits lors de la conversion automatique
googleSRET[1:10]

##  [1] NA 0.079484 0.010064 -0.041408 0.010775 0.018019 -0.016310
## [8] -0.039001 0.003529 -0.020709
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Extracting data from CRSP

Let compute our own simple returns for the entier data base and compare with the precomputed returns

google <- google %>% arrange(date) %>%
mutate(ret_s=round(PRC/lag(PRC)-1,digits=6),
test=RET==ret_s)

google

## # A tibble: 4,436 x 7

##
##
##
##
#H4
#4
#4
##
##4
##

Co~NoouhbhwWwNRE

+*
H*
=
(o}

PERMNO COMNAM
<db1l> <chr>
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE
90319 GOOGLE

INC
INC
INC
INC
INC
INC
INC
INC
INC
INC

Working Environnement and data base - LV

date
<date>
2004-08-19
2004-08-20
2004-08-23
2004-08-24
2004-08-25
2004-08-26
2004-08-27
2004-08-30
2004-08-31
2004-09-01

«. with 4,426 more rows

PRC
<db1l>
100.
108.
109.
105.
106
108.
106.
102.
102.
100.

RET
<db1>

.0795
.0101
.0414
.0108
.0180
.0163
.0390
.00353
.0207

ret_s
<db1>

.0795
.0101
.0414
.0108
.0180
.0163
.0390
.00353
.0207

test
<lgl>
NA
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
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Extracting data from CRSP

Let see if the two variables always match.

sum(googles$test,na.rm=TRUE)

## [1] 4408

It is not the case.

google %>% filter (test==FALSE)

## # A tibble:

##
##
##4
#H4
##
##
##
##
##
##

Co~NoouhdhwWNH

H+
+H+
=
(o}

PERMNO
<db1l>
90319
90319
90319
90319
90319
90319
90319
90319
90319
90319

COMNAM
<chr>

GOOGLE
GOOGLE
GOOGLE
GOOGLE
GOOGLE
GOOGLE
GOOGLE
GOOGLE
GOOGLE
GOOGLE

w With 17 more

27 x 7

INC
INC
INC
INC
INC
INC
INC
INC
INC
INC
rows

date
<date>
2004-10-21
2005-01-11
2005-02-01
2005-02-16
2005-10-28
2006-12-04
2007-04-13
2007-11-19
2008-07-28
2008-10-31

It is just marginal rounding problems.

Working Environnement and data base - LV

PRC
<db1l>
149.
194.
192.
198.
358.
485,
466.
626.
477 .
359.

0.
-0.
-0.

0.

0.

(0]

-0.
-0.
-0.
-0.

RET

<db1l>
0633 0.
00779 -0.
0190 -0.
0163 0.
0145 0.
.00842 0.
00235 -0.
0123 -0.
0302 -0.
000918 -0.

ret_s test

<db1l>
0633
00779
0190
0163
0145
00842
00235
0123
0302
000917

<lgl>
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
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Extracting data from CRSP

Let consider the continuous returns starting with some math.

vf = va.e™"

U.f _rm
U—a — €
In (Z—(Ji) = In(e"™")

r.n=In (ﬁ)
va

r = 1.ln <ﬁ>
n va

here we just consider one period (so n=1).
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Extracting data from CRSP

Let compute the continuous daily returns for Google.

google<-google %>% mutate(ret_c=log(PRC/lag(PRC)))
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Extracting data from CRSP

Let compute the final value after one period using continuous returns.
google$PRC[1] *exp(google$ret_c[2])

## [1] 108.31
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Extracting data from (RSP

Let consider now multiperiods returns.

Compute the return between date 1 [2004-08-19] and date 4 [2004-08-24].
google$SPRC[1]

## [1] 100.335
google$PRC[4]

## [1] 104.87
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Extracting data from CRSP

Let consider now multiperiods returns.

simple return

googleSPRC[4] /google$PRC[1]-1

## [1] 0.04519858
google$SPRC[1]*(1+(google$PRC[4]/googleSPRC[1]-1))

## [1] 104.87

continuous returns

log(google$PRC[4] /google$PRC[1])

## [1] 0.0442069
googleSPRC[1]*exp(log(google$SPRC[4]/googleSPRC[1]))

## [1] 104.87
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Extracting data from (RSP

simple returns intra period
googleSPRC[1]*(1+googleS$ret_s[2])*(1l+googleSret_s[3])*(l+googleSret_s[4])

## [1] 104.87

using cumprod()
googleSPRC[1]*xcumprod(l+google$ret_s[2:4])[3]

## [1] 104.87
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Extracting data from CRSP

simple returns intra period

using geometric average
googleSPRC[1]*(prod(l+googleS$ret_s[2:4])7(1/3))"3

## [1] 104.87

using a home made function for geometric average.

geomet_moy<-function(x){
y<-prod(1+x)*(1/length(x))
return(y)

}

googleSPRC[1] xgeomet_moy (googleSret_s[2:4])"3

## [1] 104.87
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Extracting data from CRSP

continuous returns intra period
googleSPRC[1]*xexp(sum(googleSret_c[2:4]))

## [1] 104.87
googleSPRC[1]*xexp(mean(google$ret_c[2:4])*3)

## [1] 104.87
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Extracting data from CRSP

Are Google return normaly distributed?
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Extracting data from CRSP

Let see it drawing a histogram.
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hist(googleSret_c,nclass = 100,
main="histogram of google stock return",xlab='return')
abline(v=mean(google$ret_c,na.rm=TRUE) ,col="red")
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histogram of google stock return

Frequency
600 800 1000 1200
| | | |

400
|

200
|

[ T I 1
-0.6 -04 -0.2 0.0 0.2

return
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Extracting data from CRSP

To be sure, let perform a Shapiro-Wilk test.
shapiro.test(google$ret_c)

H#

## Shapiro-Wilk normality test
##

## data: googleSret_c

## W = 0.74424, p-value < 2.2e-16
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Extracting data from CRSP

We also can examine the normality with a quantile-quantile plot (QQplot).
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ggnorm(googlesSret_c)
qqline(google$ret_c,col="'red"')
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Normal Q-Q Plot
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Extracting data from CRSP

Let drop the more extrem observation.
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hist(google$ret_c[which(google$ret_c>-0.68)],nclass = 100,
main="histogram of google stock return",xlab='return')
abline(v=mean(googles$ret_c[which(google$ret_c>-0.68)],
na.rm=TRUE) ,col="red'")
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histogram of google stock return
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Extracting data from CRSP

shapiro.test(googles$ret_c[which(googleSret_c>-0.68)])

##

#it Shapiro-Wilk normality test

##

## data: googleSret_c[which(google$ret_c > -0.68)]
## W = 0.90833, p-value < 2.2e-16
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Extracting data from CRSP

ggnorm(google$ret_c[which(googleS$ret_c>-0.68)])
gqqline(google$ret_c[which(google$ret_c>-0.68)],col="red")
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Extracting data from CRSP

Normal Q-Q Plot
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Extracting data from CRSP

Let estimate the CAPM Beta of Google.
What do we need?

 stock return

« market return

e risk free rate

E(ry) = a; + Bi(rmy — rfy) + €y
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Extracting data from CRSP (market index)



Extracting data from CRSP (market index)

index_CRPS <- read_csv("index_CRPS.csv")

## Rows: 4594 Columns: 11
## — Column specification
## Delimiter: ","

## dbl (11): DATE, vwretd, vwretx, ewretd, ewretx, sprtrn, spindx, totval, totc...
H#

## i Use “spec()’ to retrieve the full column specification for this data.

## i Specify the column types or set “show_col_types = FALSE® to quiet this message.
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Extracting data from CRSP (market index)

Import data in R

index_CRPSSDATE<-ymd (index_CRPSSDATE)

Working Environnement and data base - LV 105 /117




LUMEN

Extracting data from CRSP (market index)

format data.

index_CRPS_<-index_CRPS %>% select(DATE,vwretd) %>%
filter (DATE>="2004-08-19") %>%
rename (date=DATE)
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Extracting data from CRSP (market index)

merge the data with google returns.
mer_base<-left_join(google,index_CRPS_)

## Joining, by = "date"

drop omit values (NA)

mer_base<-mer_base %>% na.omit()
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Extracting data from Fama-French Portofolio and factors (risk free rate

Fama-French Portfolios and Factors

Eugene Fama and Kenneth French showed that their factors capture a statistically
significant fraction of the variation in stock returns (see “Common Risk Factors in the
Returns on Stocks and Bonds”, Journal of Financial Economics 33, 1993). The
Fama-French data source is Kenneth French’s web site at Dartmouth

Eugene Fama and Kenneth French showed that their factors capture a statistically significant fraction of
the variation in stock retums (see “Common Risk Factors in the Retums on Stocks and Bonds”, Journal of
Financial Economics 33, 1993). The Fama-French data source is Kenneth French’s web site at
Dartmouth.

Fama-French Portfolios D Cr

Fama-French Portfolios
» 2x3 Research Portfolios » 5x5 Research Portfolios

» Factors - Dally Frequency » Factors - Monthly Frequency

Working Environnement and data base - LV

Fama/French

More About This Vendor »

Knowledge Base

» Fama-French Portfolios and Factors

» Daily risk-free rate

Manuals and Overviews

» Fama French Research Portfolios and
Factors

» Size and Value in China

LUMEN
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Extracting data from Fama-French Portofolio and factors (risk free rate

This is the query form for the Fama French Factors - Daily Frequency

Step 1: Choose your date range.

Date range

2004-01-01 2022-08-20

Step 2: Choose factors for query.

How doee this work?

Factors €3

Select =a Selected Ociesra ()

A @ ExcessRewmon

> @ SmalMinus-Big Retum (smb)

High-Minus-Low Returm (hm

Risk-Free Retwm Rate (Gne Month Tressury

Q@ 0.0

Momentum (umd)

Step 3: Select query output.

How does thiz work?

Select the desired format of the output file. For large data requests, select a comprassion type to expedite
downloads. If you enter your email address, you will reoeive an email that contains a URL fo the output
file when the dats request is finished processing.

Output Format Compression Type Date Format
cead-width text (*.ba) ® Unoompressed ® YYMMDDnE. ie.g. 18840725
" comma-delimited text {*csv) DATED. je 5. 28JUL10
DOMMYYE. (2. 250784)

MMDDYY10. fe.g. O/25/1984)
DDOMMYY10. fe g. 2
YYNMDDS10. (&.g. 1984

ol spreadsniest [

SAS Windows_54
SAS Solans_5¢ datasst ("sasTodat)
dBase file (*.dbf)
STATA fle (" dtz)
PSS filz (* 52w

E-Mizil Address (Optional)

stom Figld (Optional)

Edit Praferences

Nates on this Cusn
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Fama/French

More About This Vendor »

Fama-French Portfolios and Factors »

Fama-French Portfolios

# 2x3 Research Fortiolios

» Factors - Daily Frequancy

» Factors - Monthly Frequency

Knowledge Base »

* Fama-French Portfolios and Factors

* Daiy risk-free rate

Manuals and Overviews »

» Fama Freneh Research Portfolios and
Factors

» Size and Value in China
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LUMEN

Extracting data from Fama-French Portofolio and factors (risk free rate)

Now, we can import the new data in R
risk_free_rate <- read_csv('"risk_free_rate.csv")

## Rows: 4656 Columns: 6
## — Column specification
## Delimiter: ","

## dbl (6): date, mktrf, smb, hml, rf, umd

H#

## i Use “spec()’ to retrieve the full column specification for this data.

## i Specify the column types or set “show_col_types = FALSE® to quiet this message.
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LUMEN

Extracting data from Fama-French Portofolio and factors (risk free rate)

and prepare them to be merged with our estimation sample data.

risk_free_rate <- risk_free_rate %>% select(date,rf) %>%
mutate (date=ymd(date)) %>%
filter(date>="2004-08-19"&date<="'2022-03-31")
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LUMEN

Extracting data from Fama-French Portofolio and factors (risk free rate)

Merge the data
mer_base<-left_join(mer_base,risk_free_rate)

## Joining, by = "date"
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Estimating MEDAF BETA

Variables computation
e risk premium

« market risk premium
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Estimating MEDAF BETA

mer_base<-mer_base %>% mutate(risp=RET-rf,
markrisp=vwretd-rf)
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Estimating MEDAF BETA

Let limit us to a estimation over 130 cotation days.

rega<-Im(risp~markrisp,data=filter(mer_base,date<=date[130]))
summary (rega)

##
#4
##
##
##
#H4
##
##
##
##
##
##
##
#4
##
#H4
#4
#4
##

Call:
Im(formula = risp ~ markrisp, data = filter(mer_base, date <=

date[130]))
Residuals:
Min 1Q Median 3Q Max
-0.090092 -0.021006 0.000732 0.013994 0.154748
Coefficients:

Estimate Std. Error t value Pr(>|t]|)
(Intercept) 0.004790 0.002821 1.698 0.0919
markrisp 0.567737 0.451241 1.258 0.2106

Signif. codes: 0 'xxx' 0.001 '#x' 0.01 'x' 0.65 '.' 0.1 ' ' 1
Residual standard error: 0.03182 on 128 degrees of freedom

Multiple R-squared: 0.01222, Adjusted R-squared: 0.004499
F-statistic: 1.583 on 1 and 128 DF, p-value: 0.2106
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UiSs Univarsity Management -~ ULA 4980
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If you want more about importing and managing data with R, you can watch the following video
https://youtu.be/1ICSEOMQVWAQ (31 minutes).
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https://youtu.be/1CSE0mQVwAQ

LUMEN

MAKE ME A SANDWICH.
WHAT? MAKE
IT YOURSELF.
SUDO MAKE ME /
A SANDWICH.

OKAY.

o
% A
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